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Raytracing sous Maya 
Matières - Ombres - Réflexion - Réfraction 

 

 
 
Lampes  
 
Créez un sol (polygon plane), une sphère placée au dessus du plan (polysphere) et 
une lampe directionnelle (Create > Light > Directional). Orientez les rayons de la 
lampe (avec l’outil rotation) pour qu’ils éclairent la sphère en biais par-dessus. Nous 
rappelons que la position de la lampe directionnelle n’a pas d’importance sur le 
rendu car c’est un éclairage venant de l’infini (comme le soleil). Vous devez obtenir 
une scène comme suit : 
 

        
 

Nous allons demander un rendu : un calcul de l’image associée à cette scène. Pour 
cela, allez dans Rendering > Menu > Render > Render Current Frame. La vue 3D 
courante est alors calculée. Vous devriez obtenir cela : 

 

 
 
En modifiant la direction de la lampe, faîtes varier la lumière diffusée à la surface de 
la sphère. On s’aperçoit qu’aucune ombre portée n’existe derrière la boule.  
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Les matières (Materials) 
 
Dans Maya, une matière associée à un objet décrit comment se comporte la lumière 
à la surface de cet objet. Une matière est définie grâce à un shader et une texture. 
Le shader décrit comment la lumière se réfléchit et la texture décrit comment la 
lumière se teinte. L’ensemble de ces deux informations permet d’obtenir des 
matières correspondant à la réalité : bois, plastic, marbre… Deux matières 
différentes comme le métal et un plastic peuvent avoir une même texture gris 
uniforme. Cependant, le métal va être réfléchissant tandis que le plastic sera mât. 
Cette différence de shader nous permet de distinguer visuellement les deux matières 
alors qu’elles ont la même texture. De manière similaire, si vous prenez des boules 
de Noël métalliques, elles auront le même shader, mais c’est leur texture qui 
permettra de les distinguer. Principalement, nous travaillons dans Maya avec deux 
shaders le Lambert et le Phong les autres étant des variations de ces deux derniers 
ou des modèles plus simples encore. Le Lambert est l’éclairage naturel d’une surface 
mâte sans reflet, il s’agit de la réflexion diffuse. A un point donné de la surface, le 
ratio de l’intensité lumineuse correspond au cosinus de l’angle entre la normale en ce 
point et la direction de la lumière. Le Phong est un modèle Lambert auquel on a 
ajouté la propriété de réflexion spéculaire. Cette propriété représente la capacité 
d’une surface à se comporter dans certaines conditions comme un miroir. Les 
spéculaires correspondent, entre autre, aux reflets lumineux que l’on voit sur les 
carrosseries des voitures. 

                 
                            Lambert                   Phong 
 
 
Nous allons maintenant créer notre première matière et l’associer à un objet. Allez 
dans Window > Rendering Editor > Hypershade. Nous allons nous retrouver devant 
une nouvelle fenêtre assez déroutante au début mais qui pourtant reste assez simple 
d’utilisation : 
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Dans la colonne de gauche, ouvrez le thème « Surface » et cliquez sur un Lambert 
ou un Phong. Une nouvelle matière est créée et apparait dans l’interface. 
 

 
 
 
Ne fermez pas la fenêtre Hypershade. Revenez dans la vue 3D, passez en mode 
objet et sélectionnez votre sphère. Revenez dans l’Hypershade, faîtes un click droit 
sur la matière que vous avez créée et choisissez « Assign Material to Selection ». 
Vous pouvez fermer l’Hypershade. En sélectionnant votre sphère et en demandant 
ses propriétés (CTRL A), vous allez vous apercevoir que la matière associée à la 
sphère n’est plus celle par défaut (Lambert1). Allez dans l’onglet correspondant à 
votre matière et modifiez en la couleur par défaut : 
 
 

 
 

Demandez un rendu (Render > Render Current Frame) :  
 



RAY TRACING sous MAYA                                                ESIEE 
                                                                         Lilian BUZER   Dept. Informatique 

 
 

Yes !!! Une sphère rouge avec un spéculaire !!! 
 
Par la suite, nous utilisons surtout des Phong. Pour changer les attributs de la 
matière associée à un objet, le plus simple est de le sélectionner, de faire CTRL-A et 
d’aller dans l’onglet correspondant au matériau.  
 
 
 
RAYTRACER 
 
A ce niveau, nous avons atteint les capacités maximales d’un moteur de rendu basé 
sur une méthode de type Z-Buffer. Les diffus et spéculaires sont rendus 
correctement, mais nous n’avons pas d’ombres, pas de transparence et aucune 
réfraction. Ici intervient le rôle d’un moteur de rendu basé sur un autre algorithme : un 
raytracer. Dans cet algorithme, on parcourt en sens inverse le chemin des rayons 
lumineux pour connaître la couleur des points affichés à l’écran. On imagine que les 
pixels de l’écran constituent une grille à travers laquelle l’utilisateur regarde une 
scène. Pour chaque pixel, on lance un rayon à partir de l’œil de l’utilisateur qui 
traverse le pixel en question et qui finit sa course dans la scène visualisée. Ce rayon 
rebondit, traverse ou s’arrête suivant les surfaces qu’ils rencontrent. Chaque fois qu’il 
touche une surface, on détermine si cette surface est éclairée (occlusion de la lampe 
par un autre objet) et comment la lumière est teintée par cet objet. Les différents 
résultats s’accumulent pour fournir la couleur finale du pixel considéré. 
 
 
Maya n’effectue pas obligatoirement les rendus en mode ray-trace, en effet, suivant 
ce que vous voulez faire, un Z-Buffer classique et quelques astuces sont largement 
suffisants pour avoir une belle image très rapidement. Tout dépend de ce que l’on 
recherche. Dans le monde de la 3D et en particulier pour le raytracing, tout coûte 
cher. Ainsi, les boîtes de dialogue sont par défaut configurées pour désactiver les 
effets. En bref, par défaut, rien n’est calculé ☺ pour des raisons d’optimisation. 
Activons d’abord le moteur de rendu en raytrace (changement de l’algorithme de 
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calcul). Il faut aller dans Window > Rendering Editors > Render Settings. En titre 
vous allez trouver :  
 

 
 
 

Ici, nous choisissons le software qui va effectuer les calculs de rendu. Considérez 
uniquement Maya Software et Mental Ray. D’autres moteurs de rendu peuvent être 
intégrés et cablez par l’intermédiaire de cette interface. Un software peut aussi bien 
faire du Z-Buffer que du ray-tracing, attention ne vous mélangez pas. Une fois le 
moteur sélectionné, vous pouvez aller dans l’onglet « Common ». Vous y trouverez 
des paramètres utiles comme la taille et le format de l’image calculée.  Dans Maya 
Software vous allez trouver deux sections intéressantes.  La section « Anti-Aliasing-
Quality » permet de gérer la qualité du rendu final de votre image. Je ne détaille pas 
les options, si vous voulez quelque chose d’optimal sélectionnez dans « Quality » 
l’option « Production Quality » : 
 
 

 
 
 

Ensuite la section qui nous intéresse plus directement est « Raytracing Quality », 
vous devez y cocher la case « Raytracing » pour sélectionner l’algorithme de 
raytrace pour le rendu final. 
 
 

 
 
 
Vous pouvez demander un nouveau rendu, vous devriez obtenir cela : 
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L’image est belle, mais pas d’ombre en vue. 
 
 
OMBRES 
 
Comme dit plus haut, pour des raisons d’optimisation, les ombres ne sont pas 
calculées automatiquement. Les lampes sont configurées par défaut pour désactiver 
la gestion des occlusions des rayons lumineux. Nous devons donc changer cela. 
Sélectionnez votre lampe, demandez ses propriétés (CTRL A) et allez dans l’onglet : 
Shadows > Raytrace Shadows Attributes et activez « Use Ray Trace Shadow ». 
Maintenant, votre lampe va générer des ombres.  
 

 
 
De la même manière, si vous demandez que votre lampe génère des ombres en 
raytrace mais que votre moteur de rendu n’est pas en mode raytrace, vous n’aurez 
pas d’ombre au final. Maya ne fournit pas de messages d’erreur car pour lui il n’y en 
a tout simplement pas. Il s’agit de vos configurations qu’il se borne à appliquer. 
Réfléchissez aux options que vous avez pu oublier lorsque ce que vous attendiez à 
l’écran n’apparaît pas. Demandez un calcul du rendu : 
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Nous retrouvons à ce niveau les ombres bien dures typiques d’un calcul par 
raytracing. Il s’agit de la concrétisation visuelle du test booléen d’occultation : mon 
point courant reçoit-il des rayons lumineux de la lampe ? Il y a dans les paramètres 
de la lampe deux options permettant de « corriger » cet effet d’ombre coupée au 
couteau. En faisant varier le « light angle » :  
 
 

 
 
durant leur parcours en sens inverse, vos rayons lumineux ne rebondissent plus de 
manière idéale (angle d’incidence = angle de réflexion) mais ils vont subir une légère 
variation aléatoire au maximum égale au « Light Angle ». Ceci va perturber le 
contours parfait de vos ombres : 
 

 
 
 

Par contre, un effet de mouchetis apparaît. Cela est du au côté aléatoire de cette 
méthode. Pour compenser le problème, l’astuce va consister à envoyer plusieurs 
rayons pour un même pixel, à récupérer les résultats et à les moyenner. Les légères 
perturbations effectuées par la déviation aléatoire du « Light Angle » font que ces 
rayons ne vont pas parcourir le même chemin inverse. Pour, modifier le nombre de 
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rayons envoyés pour chaque pixel, rentrez la valeur correspondante dans le 
paramètre : « Shadows Rays » : 
 

 
 
Calculez un nouveau rendu : 

 

 
 
La qualité est très bonne, cependant, l’augmentation du temps de calcul se fait 
lourdement ressentir. Ne serait-elle pas linéaire en fonction du paramètre « Shadow 
Rays » ? Par la suite, vous devriez réinitialiser les paramètres « Light Angle » et 
« Shadow Rays », cela vous fera gagner de précieuses secondes. 
 
 
PARAMETRES DU MATERIAU 
 
Sélectionnez votre sphère, demandez ses attributs et allez dans l’onglet de sa 
matière. Vous allez trouver différentes informations utiles : 
 
 
Dans « Common Material Attribute » : 
 
- Color : couleur pour un objet uni. Vous 

pouvez la changer en cliquant sur le 
rectangle. 

 
- Transparency : règle l’opacité / 

transparence de votre objet  
 
- Diffuse, règle le % de lumière à 

renvoyer par le modèle d’illumination 
réflexion diffuse. Ce paramètre agit 
comme un potentiomètre en se réglant 
entre 0 (rien) et 1 (~100%) 

 
- Bump Mapping : permet d’associer une 

texture de bumpmap à votre objet 
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Si vous avez choisi un Phong, vous aurez une 
catégorie supplémentaire : « Specular Shading »  
 
- cosine power : concentration de l’effet 

spéculaire, plus il est haut, moins le reflet est 
large. Il s’agit tout simplement de la valeur de 
l’exposant dans la formule du spéculaire. 

 
- Reflectivity : réglage du comportement 

miroir, 1 ~ surface réfléchissante, 0 ~ mâte 
 
A ce niveau, il faut remettre un peu les points sur les i. En effet, nous avons vu dans 
le cours sur la lumière qu’il ne pouvait exister que trois comportements pour la 
lumière : l’absorption,  la réflexion diffuse (le rayon lumineux incident rebondit en 
éclatant dans toutes les directions) et la réflexion spéculaire (le rayon lumineux 

rebondit selon la loi de Descartes i=r). Hors ici, dans l’onglet spéculaire, on gère 

deux types de réflexion spéculaire, celle obtenue par le calcul en cos
n
 et celle 

obtenue par rebond sur un miroir (reflectivity). Que se passe-t-il ? Il s’agit pourtant du 
même modèle de réflexion, cependant la différence se situe sur un plan 

algorithmique. En effet, le terme en cos
n
 correspond au spéculaire formé par l’arrivée 

d’un rayon lumineux provenant directement d’une source lumineuse (d’une lampe). 
La formule consacrée permet donc de calculer directement sa valeur et c’en est fini 
pour lui. Dans le cas où le rayon ne provient pas d’une lampe, il faut le relancer 
(récursivement) pour parcourir le chemin du rayon lumineux en sens inverse. Cette 
partie est gérée par l’algorithme de raytracing. Pourquoi deux modèles ? Le 
deuxième (loi de Descartes) correspond à la réalité physique et devrait être suffisant. 
C’est exact, cependant, cela serait possible si dans nos logiciels de 3D les sources 
lumineuses avaient une existence physique, mais ce n’est pas le cas. Pensez à la 
lumière du soleil modélisée par une lampe directionnelle, le soleil n’est pas un objet 
3D dans notre scène. Cette différence entre la lumière provenant de sources 
lumineuses et la lumière provenant de la surface des objets se traduit ainsi sur le 
plan algorithmique.  
 
Dans un dernier onglet intitulé « Raytrace 
Options », vous trouverez : 
- Refractions (activation) 
- Refractive index : l’indice de réfraction 

correspondant à la loi de Fresnel : n1 sin i1 = 

n2 sin i2. Pour rappel, l’air a un indice de 1, 
le verre 1,5 et l’eau 1,33 

 

Réfraction 
 
Partez d’une nouvelle scène, créez un sol et deux sphères auxquelles vous 
associerez un Phong. Pour produire un effet de réfraction, il faut augmenter la 
transparence (sinon vos surfaces sont opaques !!!) et donnez un indice de réfraction 
qui ne soit pas identique à l’air. Enlevez la « reflectivity » pour avoir un objet mât. En 
effectuant un rendu vous devriez obtenir ceci : 
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Arghh… la transparence est bien là, mais la réfraction n’est pas au RDV. Oups, il faut 
passer le moteur en mode raytrace : Window > Rendering Editors > Render Settings 
> Maya Software > Raytracing Quality > activez raytracer. Pour rendre un effet de 
bille de verre, autant ne pas se tromper dans les paramètres !! Le verre n’a pas de 
couleur et il est totalement transparent. Son indice de réfraction doit être fixé à 1.5. 
Demandez un nouveau rendu : 
  

 
 
 
Testez le comportement de la réfraction, en utilisant un sol de type damier. Pour cela 
créez un rectangle, au lieu de lui fixer une couleur, cliquez à droite sur le fanion : 
 

 
 

 
Choisissez alors une texture damier type « Checker » : 
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Une fois cliqué, vous allez trouver une fenêtre de paramètre pour les couleurs du 
damier. Profitez en pour changer la couleur noire en bleu par exemple. 
 
 

 
 
 
Vous devriez obtenir la scène suivante :  
 
 

 
 
 
 
Faîtes maintenant varier l’indice de réfraction et demandez plusieurs calculs de 
rendu pour comparer : 
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Avec une transparence totale et un indice de 
réfraction identique à l’air !!! Votre boule se 
comporte comme de l’air et devient 
complètement invisible !!! 
 
 
 
 

 
 

    
              Indice réfraction : 1.2                                  Indice réfraction : 1.6 
 
Attention, l’effet produit par la réfraction dépend de la distance entre la sphère et le 
plan aussi bien que de la grosseur de la boule. Ne vous étonnez pas d’avoir des 
rendus très différents de ceux présentés ici. 
 
 
 
REFLEXION 
 
Nous allons essayer de produire un effet miroir en activant la réflexion spéculaire 
dans l’algorithme de raytracing. Avant de modéliser un miroir, il faut faire attention à 
certains points importants sans lesquels la simulation ne fonctionnera pas :  
- La première erreur est d’attribuer une couleur, généralement du blanc, au miroir. 

Cela sous-entendrait que la surface de votre miroir diffuse de la lumière, ce qui 
n’est pas le cas. Donc la couleur de votre miroir doit être noire. 

- Le paramètre de réflexion spéculaire (reflectivity) doit être à 100% 
- Un miroir n’est pas transparent !!! Donc mettez « transparency » à 0% 
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Mettez deux boules côte à côte pour obtenir un joli effet de miroir entre les deux 
boules. Effectuez un rendu : 

 
 

 
Objets miroir seuls 

 
 
Généralement, le rendu donne un écran noir. Seuls les spéculaires sont visibles. 
Etrange… c’est décevant comme résultat. Tout est correctement paramétré, mais 
nous avons oublié une notion de base de la physique : on ne peut avoir un effet de 
miroir uniquement si le miroir a quelque chose à réfléchir !! Ainsi en créant des objets 
ayant une réflexion diffuse classique, les réflexions vont commencer à apparaître à la 
surface des boules : 
 
  

 
 
 
Mais le rendu est encore bien terne. Pour produire l’effet métallique que nous 
attendons inconsciemment, il faut se rappeler que les objets métalliques que nous 
voyons sont plongés dans un environnement. Ils réfléchissent ainsi les objets dans la 
pièce ainsi que les diverses sources lumineuses présentes. N’ayant pas le temps 
d’intégrer un environnement complet dans notre décor, nous allons modéliser 
simplement les murs d’une pièce en mettant nos sphères dans un cube assez large. 
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Sur le cube, demandez une texture de type damier. Positionnez au moins deux 
lampes directionnelles de façon à ce que les murs et le sol soient éclairés. Zoomez 
suffisamment pour que votre vue 3D soit à l’intérieur du cube. La scène devrait 
ressembler à quelque chose comme cela : 
 
 

 
 
 
Effectuez un rendu, n’oubliez pas de configurer le moteur en mode raytracer, vous 
pouvez donner des couleurs aux lampes  : 
 
 

 
 

Vous remarquez une erreur dans l’image. En effet, l’image miroir d’une boule par 
rapport à une autre boule est une sphère noire. Que s’est-il passé ? L’algorithme de 
raytracing a effectué le calcul du chemin inverse du rayon lumineux, le rayon est allé 
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tapé sur la première sphère, le rebond a été déterminé et le rayon est allé sur la 
deuxième sphère. A ce niveau, l’algorithme s’est arrêté et la couleur diffuse a été 
calculé. Par défaut, le métal étant noir, la couleur apparente est noire. Ainsi la sphère 
apparaissant à travers l’image miroir de l’autre sphère est noire. Comment corriger 
cela ? En interne l’algorithme de raytrace « bride » le nombre de rebond à 1 pour 
éviter de trop nombreux calculs. Nous allons modifier cette limite en corrigeant à 2 le 
terme « Reflection Limit » dans les paramètres du Phong : 
 

 
 
 Il faut aussi le changer dans les paramètres du moteur, Window > Rendering Editors 
> Render Settings > Maya Software > Raytracing Quality > Reflections. 
 

 
 
Après ces modifications, effectuez un nouveau calcul de rendu et comparez : 
 
 
 


